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1. System configuration

The following driver is CHINO KOREA's “THYRISTOR REGULATOR”
Depending on the external device (MODBUS Slave Protocol supported), you may set the “command code”, “protocol frame format”

etc., of the driver separately. In this case, set the detailed settings according to the external device side based on the communication
method.
The system configuration with an external device supported by this driver is as follows:

Communication

Link I/F System settin
/ method y 9

3.1 Settings example 1 5.1. Cable table 1
RS-232C
(Page 4) Page 10
RS-422 3.2 Settings example 2 5.2. Cable table 2
THYRISTOR REGULATOR .
(4 wire) (Page 5) (Page 11)
RS-485 3.3 Settings example 3 5.3. Cable table 3
(2 wire) (Page 6) (Page 12)

W Connection configuration MODB U S

+ 1:1 (one TOP and one external device) connection — configuration which is possible in RS232C/422/485 communication.
TOF

] mm-

+ 1:N (one TOP and multiple external devices) connection — configuration which is possible in RS422/485 communication.

) (]

| ' «j | -::-ZI .........

L
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2. External device selection

W Select a TOP model and a port, and then select an external device.

Select Device [ =]

PLC select [COM2]

Fiter : [[all ] Search :
@®Model  (OVendor

Vendor Model
IDEC Corporation @

HAWE HYDRAULIK
SEHAN Electools
TOHO Electronics Inc.
IAI Corparation

MKP

TEMCOLINE Co., Ltd.
LINMOT

KOLVER Srl
SENGENULTY

PELCO

FASTECH Co., Ltd,

HYOSING

@Bk | W Next ® Cancel

Select Device [ =]

PLC Setting[ Thyristor ]

Alias Name : |PLC1

Interface : |Serial ~

Protocol : | MODBUS RTU v Comm Manual
String Save Mode : [First LH HL Change

[ use Redundancy
AND ~

Primary Option

Timeout msec
Send Wait msec

Slave ID -

Address Mode

[0 Device Optian]

Max Read Count o0 =

Write Function [Function 0x05
Max Write Count 512 =
ReadBitunit 16 -
[1Device Option]
Max Read Count
ReadBitunit
125 5
125 =

[3 Device Option]

Max Read Count
[4Device Option]

Max Read Count :l

Write Function Function 0x06

Max Write Count 100 5
4 Back VoK ¥ Cancel
Settings Contents
TOP Model Check the TOP display and process to select the touch model.
External device | Vendor Select the vendor of the external device to be connected to TOP.
Select “chino”.
PLC Select an external device to connect to TOP.

Interface Protocol

THYRISTOR REGULATOR Serial Set Users

Supported Protocol
MODBUS RTU MODBUS ASCII

Please check the system configuration in Chapter 1 to see if the external device you want to

connect is a model whose system can be configured.
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3. TOP communication setting

The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that

of the external device.

3.1 Communication setting in

TOP Design Studio

(1) Communication interface setting
W [Project > Project Property > TOP Setting] — [Project Option > “Use HMI Setup” Check > Edit > Serial]
— Set the TOP communication interface in TOP Design Studio.

Project Option *
-ChangeHMllﬂ] S 2acPic TR Change PLCIC | [ Delete PLCID)
E%PCVIEW[SIDX Date / Time Sync. =~ Screen Option | Unit Convert
e v‘-’Di"Ea;El“(’g)ﬂ Project Option | Screen Change | HmiSetup | Global Lock & Touch | Project Style | PLC Buffer Sync.
vEmcoM(mn Use HMI Setup
’.';p:‘;(;ul)-Thwlsmr t Hmi Setup Uption Initialization | Edit |
&% COM4 (0) Project Setting -~
w Ethernet (0) HMIDisable=0
Project Name=New project
Start Mode=Menu
Start Screen No. =1
Latch Use=0
Latch Set=0~0
Communication Error Message =0
USBErrorMessage=0
StorageErrorMessage=1
93!2ba§_eMessaga_=1
Control Panel
. [ | i |
System m Devices .
o Serial *
- at Serial Port: | COM2 <
T (S _
Signal Level
FLC Security Date/Ting (@ RS-232C () RS-422(4) O RS-485(2)
Baud Rate: 19200 =
[,J-L.] ol o o K Data Bit: 8 -
[ -
Stop Bit: |1 S
Et hernet Serial HOM |
Parity Bit: [MNone S
— Flow: [Off
L A Auto Search  Loopback Test
Fing
Diagnost ic File Fing
=S Apply = Cancel
Items TOP External device Remarks
Signal Level (port) RS-232C
RS-422/485
Baud Rate 19200
Data Bit 8
Stop Bit 1
Parity Bit None.
* The above settings are examples recommended by the company.
Items Description
Signal Level Select the serial communication method between the TOP and an external device.
Baud Rate Select the serial communication speed between the TOP and an external device.
Data Bit Select the serial communication data bit between the TOP and an external device.
Stop Bit Select the serial communication stop bit between the TOP and an external device.
Parity Bit Select the serial communication parity bit check method between the TOP and an external device.
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(2) Communication option setting
M [Project > Project Property > Device Setting > COM > “PLC1 : chino”]
— Set the options of the THYRISTOR REGULATOR communication driver in TOP Design Studio.

Project Option x

B cranoe Hi B Adapc T Change FLCIC) | [T Delete PLCID]

~ [ TOP Setting a N
;T PLC Setting[ Thyristor
[ SYS : TOP-PCVIEW1510% gl Thy! !

v g Device Setiing Alizs Name : [PLC1

comM1 (o) Interface : | Serial 4

Protocol : | MODEBUS RTU ~
String Save Mode : [First LHHL Change

[ use Redundancy
AND v

Comm Manual

\..qg Ethernet (0)

Primary Option

Send Wait 0 <[ msec A
Retry 5 <
Slave ID 1 =

Address Mode

[0 Device Option]

Max Read Count 2000 =
Write Function W‘
Max Write Count 512 =
ReadBitUnit a4 -

[1 Device Option]

Max Read Count 2000 =
ReadBitUnit 4
[3 Device Option]
Max Read Count 125 =
[4 Device Option]
Max Read Count 125 =
Write Function Function 0x08 ~
Max Write Count 54 = -
Apply Close
Items Settings Remarks
Interface Select “Serial". .,
— Refer to "2. External
Protocol Select the communication protocol between the TOP and an external . .
. device selection”.
device.
TimeOut (ms) Set the time for the TOP to wait for a response from an external device.

. Set the waiting time between TOP's receiving a response from an external
SendWait (ms)

device and sending the next command request.

Slave Equipment Address No | Enter the prefix number of an external device (Slave).

Address Mode Select the Address Mode. (1-base: “address-1" operation/0-base: no

operation)

[0 Device Option]

Max Read Count Set the maximum number of consecutive reads for the Coil.

) . Set the write command for the Coil.
Write Function

Force Single Coil : 05(Hex) / Force Multiple Coils : OF(Hex)

Max Write Count Set the number of consecutive writes for the Coil.

ReadBitUnit Bit read amount(Cannot be configured from the main body)

[1 Device Option]

Max Read Count Set the number of consecutive reads for the Discrete Input.

ReadBitUnit Bit read amount(Cannot be configured from the main body)

[3 Device Option]

Read Boundary Set the number of consecutive reads for the Input Register.

[4 Device Option]

Max Read Count Set the number of consecutive reads for the Holding Register.

. . Set the write command for the Holding Register.
Write Function

Preset Single Register : 06(Hex) / Preset Multiple Registers : 10(Hex)

Max Write Count Set the number of consecutive writes for the Holding Register.
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3.2. Communication setting in TOP

* This is a setting method when "Use HMI Setup” in the setting items in "3.1 TOP Design Studio” is not checked.

W Touch the top of the TOP screen and drag it down. Touch “EXIT" in the pop-up window to go to the main screen.

(1) Communication interface setting

M [Main Screen > Control Panel > Serial]

Conit:roll Panel

ar serial
@ System
Run )
y 0 Serial Port: [CUME |']
i} ‘. Signal Level
‘ g ® RS-232C ) RS-422(4) () RS-485(2) ]
PLC Security O
Baud Rate: | 19200 -~
¥NC L
Viewer [r'-'ﬂ] rl‘ 1l Data Bit: [8 I']
e I Stop Bit: | 1 -]
Ethernet Serial
Parity Bit: | None -]
m = Flow: [0Off B =
D BEE % ! lAuto Search] [Loopback Test] V
Manager
[ Apply J[ Cancel J -

[System]

TOPRX - TOPRX0800S

Close

A 2021-08-31

04:36:08 PH

Items External device Remarks
Signal Level (port) RS-232C
RS-422/485
Baud Rate 19200
Data Bit 8
Stop Bit 1
Parity Bit None.

* The above settings are setting

examples recommended by the company.

Items Description

Signal Level Select the serial communication method between the TOP and an external device.

Baud Rate Select the serial communication speed between the TOP and an external device.

Data Bit Select the serial communication data bit between the TOP and an external device.

Stop Bit Select the serial communication stop bit between the TOP and an external device.

Parity Bit Select the serial communication parity bit check method between the TOP and an external device.
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(2) Communication option setting
M [Main Screen > Control Panel > PLC]

Conit:roll Panel

- Serial

Run
| Serial Port: [CUME I~
!ll‘l G Signal Level
‘ - ® R5-232C O RS-422(4) O RS-485(2)

Security o
Baud Rate: | 19200

o e Data Bit: |8 :
iewer s | ata Bit:
] | - Stop Bit: | 1 -
Ethernet Serial
Parity Bit: | None "
|

Flow: [Uff

Diagnost ic File
Manager

i)
N

[Auto Search] [Loopback Test]

[ App ly J[ Cancel ‘ —

Close

[System]

TOPRX - TOPRX0800S A 2021-08-31 04:-36-08 PH

Items Settings Remarks

Interface Select “Serial”. Refer to "2. External
Protocol Select the communication protocol between the TOP and an external device. device selection”.
TimeOut (ms) Set the time for the TOP to wait for a response from an external device.

SendWait (ms) Set the waiting time between TOP's receiving a response from an external
endWait (ms
device and sending the next command request.

Slave Equipment Address | Enter the prefix number of an external device (Slave).
No

Address Mode Select the Address Mode. (1-base: "address-1" operation/0-base: no operation)

[0 Device Option]

Max Read Count Set the maximum number of consecutive reads for the Coil.

) . Set the write command for the Coil.
Write Function . . ) .
Force Single Coil : 05(Hex) / Force Multiple Coils : OF(Hex)

Max Write Count Set the number of consecutive writes for the Coil.

ReadBitUnit Bit read amount(Cannot be configured from the main body)

[1 Device Option]

Max Read Count Set the number of consecutive reads for the Discrete Input.

ReadBitUnit Bit read amount(Cannot be configured from the main body)

[3 Device Option]

Read Boundary Set the number of consecutive reads for the Input Register.

[4 Device Option]

Max Read Count Set the number of consecutive reads for the Holding Register.

. . Set the write command for the Holding Register.
Write Function ) . ) .
Preset Single Register : 06(Hex) / Preset Multiple Registers : 10(Hex)

Max Write Count Set the number of consecutive writes for the Holding Register.
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3.3 Communication diagnostics

B Check the interface setting status between the TOP and an external device.
- Touch the top of the TOP screen and drag it down. Touch "EXIT" in the pop-up window to go to the main screen.
- Check if the COM port settings you want to use in [Control Panel > Serial] are the same as those of the external device.

W Diagnosis of whether the port communication is normal or not
- Touch "Communication diagnostics" in [Control Panel > PLC].

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status.

oK Communication setting normal

Time Out Error Communication setting abnormal

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet)

B Communication diagnostics sheet
- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below.

Items Contents Check Remarks
System How to connect the system oK NG ) .
' . ) 1. System configuration
configuration Connection cable name OK NG
TOP Version information OK NG
Port in use OK NG
Driver name OK NG
Other detailed settings oK NG
Relative prefix Project setting oK NG
Communication 2. External device selection
) . oK NG . -
diagnostics 3. Communication setting
Serial Parameter Transmission
OK NG
Speed
Data Bit OK NG
Stop Bit oK NG
Parity Bit oK NG
External device CPU name OK NG
Communication port name (module name) OK NG
Protocol (mode) OK NG
Setup Prefix oK NG
Other detailed settings oK NG . .
4. External device setting
Serial Parameter Transmission
oK NG
Speed
Data Bit OK NG
Stop Bit oK NG
Parity Bit oK NG
Check address range 6. Supported addresses
OK NG (For details, please refer to the PLC
vendor's manual.)
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4. External device setting

Refer to the vendor’s user manual to identically configure the communication settings of the external device to that of the TOP.
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5. Cable table

This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device.

(The cable diagrams described in this section may differ from the external device vendor’s recommendations.)

W RS-232C (1:1 connection)
TOP External device
Pin Signal Pin Cable connection Signal
arrangementNote 1) name number name
1 5 CD 1
(@ Q) RD 2 SD
Q o ) 3 RD
6 9
DTR 4 DTR
Based on
. SG 5 SG
communication l_
DSR 6 DSR
cable connector
f RTS 7 E RTS
ront,
D-SUB 9 Pin male CTs 8 Crs
9

(male, convex)

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.

W RS-422 (1:1 connection)

TOP External device

Pin Signal Pin Cable connection Signal

arrangementNote 1) name number name

1 5 RDA(+) 1 SDA(+)

(o} o) p) SDB(-)

Q e 3 RDA(+)

4 Based ong RDB(-) 4 RDB(-)

communication 3G > G

cable connector SDA(+) 6
front, !
D-SUB 9 Pin male 8
(male, convex) SDB(-) 9

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.

W RS-485 (1:1 connection)

TOP External device

Pin Signal Pin Cable connection Signal

arrangement*Note 1) name number name

1 5 RDA(+) 1 SDA(+)

QO o) 2 SDB(-)

(e] Q 3 *— RDA(+)

4 Based ong RDB(-) 4 RDB(-)

communication 3G > 3G

cable connector SDA(+) 6
front, !
D-SUB 9 Pin male 8
(male, convex) SDB(-) 9

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.
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M RS-485 (1:1 connection)

TOP External device
. Signal Cable connection Signal
Pin arrangement
name name
_ + SDA(+)

(
sG SG RDA(+)

[Oeee|O]
|

M RS-422 (1:N connection) — Refer to 1:1 connection to connect in the following way.

TOP ) ) o External device Cable connection and signal External device
————— Cable connection and signal direction - o -

Signal name Signal name direction Signal name
RDA(+) SDA(+) SDA(+)
RDB(-) SDB(-) SDB(-)
SDA(+) RDA(+) RDA(+)
SDB(-) RDB(-) RDB(-)

SG SG SG

B RS-485 (1:N/N:1 connection) — Refer to 1:1 connection to connect in the following way.

TOP ) ) o External device Cable connection and signal External device
————— Cable connection and signal direction - . -

Signal name Signal name direction Signal name
RDA(+) SDA(+) ) SDA(+)
RDB(-) SDB(-) J SDB(-)
SDA(+) — RDA(+) RDA(+)
SDB(-) RDB(-) T RDB(-)

SG SG SG
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6. Supported addresses

The devices available in TOP are as follows:

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address
range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the
address range supported by the device you want to use.

Bit Address Word Address 32 bits Remarks
Coall 001001 — 065536 001001 — 065521
Discrete Input 101001 — 165536 101001 — 165521 UH *Note 1)
Input Register 301101.00 — 365536.15 301101 — 365536 *Note 1)
Holding Register 401001.00 — 465536.15 401001 — 465536

*Note 1) Cannot be written (Read-only)
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Appendix A. Standard MODBUS Protocol

Describes MODBUS protocol commands and devices supported by “"MODBUS Serial Master Driver” of this device.

At the message level, the MODBUS protocol still applies the master—slave principle even though the network communication
method is peer—to—peer. If a controller originates a message, it does so as a master device, and expects a response from a slave

device. Similarly, when a controller receives a message it constructs a slave response and returns it to the originating controller.

Query message from Master

Device Address Device Address
Function Code Function Code
Eight-Bit | | Eight-Bit
— Data Bytes —] — Data Bytes —
Error Check Error Check

Response message from Slave

The Query: The function code in the query tells the addressed slave device what kind of action to perform. The data bytes contain
any additional information that the slave will need to perform the function. For example, function code 03 will query the slave to
read holding registers and respond with their contents. The data field must contain the information telling the slave which register
to start at and how many registers to read. The error check field provides a method for the slave to validate the integrity of the
message contents.

The Response: If the slave makes a normal response, the function code in the response is an echo of the function code in the query.
The data bytes contain the data collected by the slave, such as register values or status. If an error occurs, the function code is
modified to indicate that the response is an error response, and the data bytes contain a code that describes the error. The error
check field allows the master to confirm that the message contents are valid.
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A1 “0"” Device (Coil)

Read Single Coil :

01

Describes “01" command frame through the example where “000020-000056 Coil” data of the Slave device side (prefix: 17) is read
from the MASTER device.

M RTU Mode
(Master > Slave: request frame)
0O (%) Q) — o (@)
3 . 3 =3 © ~
s 3 |2 | @ 2 g
ER e |8
< e
: E
H L |lH L | L H
Hex |11 |01 00| 13|00 25| —|— B Coils data status
(Slave > Master: response frame) B 27 | 260 25| 24 23 | 22 | 217} 20
- - - - N on/off 1 1 0 0 1 1 0 1
312 |3 |5 (Data ) ] Coils | 35|34 |33]32|31]30]29] 28
2= |2 |8 ~ onfoff | o | 1 |1 o 1o 1]
2 |3 2 2 | o o N I N 3
2 S /2 1822 |8 s Coils | 43 | 42 | 41 [ 40|39 38]37]36
S8 e |alalg 3 onfoff | 1 o |11 o]o|1]o0
- IO IO IV (O G S = Coils | 51 | 50 | 49 | 48 | 47 | 46 | 45 | 44
u o [e=] (&) N NN
on/off | 0 0 0 0 1 1 1 0
L - - - H| L H :
Coils | 59 | 58 | 57 | 56 | 55 | 54 | 53 | 52
Hex | 11| 01 |05 |co |68 |B2|oE|1B|—|— ongoff | - | - | - | 10100l
0: OFF / 1:O0N
Hl ASCIl Mode
(Master > Slave: request frame)
8 | # 2 2 ) g Q g
3 I s 3 S <. 2
3 @ 3 =1 o ~
o] = ° ) @ " a
= g 3 s 8 g
=<’ "<D % )
: =
(e}
H L|lH L|H - - Ll|lHw - = Ll L H
ASCII 1 1 0 1 0 0 1 3 0 0 2 5 CR LF
Hex | 3A[31] 313031 |30|30]31]33]30[30]32]3]|—|—|op]oa
(Slave - Master: response frame)
I T [%) ) T z o) =
S e 3 S | %5 pata g .
2 |9 3 3 c 8 a
=} 0] 3 o
- = o o [a) [a) [a) [a) [a) o
= = o o o o o o
& & & & & = =
& 3 & 5 a % 3
5 : : L Z
o [o¢] (o)} N \S]
H L|H L|H L|lH L|H L] H
ASCII 1 1 0 1 0 5 C D 6 B B 2 0 E 1 B CR LF
Hex | 3a 31|31 |30[31 3035|4344 36|42 42|32]30]45[31]42]—]—|o]on
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Force Single Coil : 05
Describes “05” command frame through an example where FORCE "“ON" is done on Coil 000173 of the Slave device side in the MASTER

device.
H RTU Mode
(Master > Slave: request frame) /\»
/ W Force Data
e g & o g Q High  Low
3 |5 |3 o a 2
3 .| 3 3 a ~ Force ON FFy 00y
2 ol 3 a & S
;—2 o ) B % Force OFF 004 00y
<
) 3
o

H L H L L H
Hex | 11| 05 | 00 | Ac | FF |00 | —

(Slave > Master: response frame

N

JuUsWIWOD)

xiy24d ane|s
puewwod

921nap Bulpea
elep 92404

(D¥D) 8pod HayDd

H L H L L H
Hex | 11| 05 |00 | Ac | FF |00 | — | —

H ASCIl Mode
(Master - Slave: request frame)
8 |z | ¢ 9 5 g o Sy
@® = ° D Q o a
2 g 2 o & 4
2 2. Q B
- -
8
H oL |H L|lH - - L|lH - - Ll L H
asci | : 1 1o s{o o 1 3|0 0o 2 s CR LF
Hex |3 [ 31313031 |30 |30 |41 ]43]45]45]30]30|—|—|op]oa
(Slave - Master: response frame)
3 |3 5 3 5 e ~
S| 3 E = & 8
2 5 3 5 5 8
B [
8
H L H L H - - L H - - L L H
asci | : 1 1o s|o o 1 3|0 0o 2 5 CR LF
Hex | 3A |31 ] 313031 |30 30|41 ]43]45]45]30]30] —|—|op]oa
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A.2 “1" Device (Discrete Input)

Read Input Status : 02
Describes “02" command frame through an example where “100197-100218 Input” data of the Slave device side (prefix: 17) is read
from the MASTER device.

H RTU Mode
(Master > Slave: request frame)

JUBWIWOD
xiya1d anels
puewwod
221A9p Bulpea
21025 ad1n8Qg

(0¥D) 8pod HaYd

H L |H L |L H
Hex |11 |02 | 00| caloo|6] —|—

(Slave > Master: response frame) ___— —> W Coils data status
I % ) = o) Coils 204 | 203 | 202 | 201 | 200 | 199 | 198 | 197
o o o c Data (Inputs) a
3 S 3 3 a on/off 1 0 1 0 1 1 0 0
3 |3 |3 |g ~
A I T T e I R 3 Coils | 212 | 211 | 210 | 209 | 208 | 207 | 206 | 205
=4 o o o o %
o o o . on/off 1 1 0 1 1 0 1 1
QRIS | @)
2 KX N S Coils 220 | 219 | 218 | 217 | 216 | 215 | 214 | 213
o o o =
e |13 IR IR on/off | - - 1 1 0 1 0 1
o ~ [l w
0: OFF / 1:0N
L H
Hex |11 02 |03 |Ac|DB|35 | — | —
W ASCIl Mode
(Master > Slave: request frame)
a T %) ) — o (@) Iy
BE 3 3 ] 2 g
3 5 3 5 3 ~
® = ° o @ " a
= ® =} a A o
= (o @ o o
o < 3 o
8 =
o
H L H L H - - L H - - L] L H
ASClI 1 1 0 2 0 0 C 4 0 0 1 6 CR LF
Hex | 3A |31 )31 3032|3030 |43]34]30]30]31]36|—|—|op]oa
(Slave > Master: response frame)
) T %) ) bl o) =
8 g % g g Data (Inputs) ?::- B
3 |2 =l 5 g N
2 e, 2 ° o - o g
X o 2 2 i~ @
& ® N S =
@ 2 13 3 g
G =) = S -
< - N N
I © o =
K22 ~ [%2] w
H L H L H L L H
ASClI : 1 1 0 2 0 3 A C D B 3 5 CR LF
Hex | 3A 31|31 30|31 [3035|41]43|44]42|33|35|—|—|op]oa
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A3 “3" Device (Input Register)

Read Input Registers : 04

Describes “03" command frame through an example where “300009 Register” data of the Slave device side (prefix: 17) is read from

the MASTER device.

H RTU Mode
(Master > Slave: request frame)
3 |5 |3 5 s 3 ~
@ ° o @ A w a
2 1% |2 o e g a
X 3 R o
H L H L L H
Hex |11 |04 | 00| 08|00 |01 | —|—
(Slave > Master: response frame)
) %] I z e
g % g 5 Data 2?
[0}
o) 8 T [a
[0}
g| 7% | B
3
H L L H
Hex | 11|04 |02 ] 00 0A| —|—
Hl ASCIl Mode
(Master > Slave: request frame)
3 | & i 3 Ef g3 ~
g |- 3 3 < 2 8
) 7 - g 5 3
: E
o
H L H L H - - L H - - L] L H
ASCII : 1 1 0 1 0 0 0 8 0 0 0 1 CR LF
Hex | 3A[31] 313031 |30 |30|30]38]30[30]30]3|—]—|op]oa
(Slave - Master: response frame)
) T %) I S Z e =
s8] 2 2 |35 Data 2 =
3 (%] = 5 8 5
> ® > = o
- 2 o =N 5 7 3
a > < —_
= o 4 [
QO Q O
H - - L L H
ASCII : 1 1 0 4 0 2 0 0 0 A CR LF
Hex | 3a 31 [ 31|30 ]31[3035[30 ]3304 |—|—]oo]oa
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A4 “4" Device (Holding Register)

Read Holding Registers : 03
Describes “03" command frame through an example where “400108 — 400110 Register” data of the Slave device side (prefix: 17) is read

from the MASTER device.

M RTU Mode
(Master > Slave: request frame)
g 1g |9 ) 5 Q
3 |5 |32 = & 3
3 . 3 5 © ~
S |5 |5 < 2 3
A o R : 3
? 2
H L | H L L H
Hex | 11|03 | 00|68 |00 03] —|—
(Slave - Master: response frame)
) [%) ) z o)
3 % g 5 Data §
3z |2 |28 5
3 o
F R e eE |gE |&g | =
& 8T 3z = 'Q
— [0} [0] ®
%‘ =2 = 2 o
H L | H L | H L L H
Hex | 11| 03 | 06 | 02 | 28 |00 | 00 | 00 |64 | — | —
W ASCIl Mode
(Master > Slave: request frame)
aQ T %) [} e = O [@) o
s | & 2 g 2 58 2 )
3 | & hid 3 5 g3 ~
R 3 g e @ 8
2 < g ° &
B =
o
H L | H L | H - - L | H - - Ll L H
ASCII : 1 1 0 1 0 0 1 3 0 0 2 5 CR LF
Hex | 3A |31 ] 313031 |30|30]31]33]30[30]32]3]|—]—|op]oa
(Slave - Master: response frame)
g % ) 9 § £ Data z E_’
3 2 5 3 o 3 2
3 |2 =l 5 < g ~
3 2 g 2 57 57 57 g
o = Q = Q = Q 2
2] &z 8z sz [
8 % % 3 3
H - L | H - L | H - L L H
ASCII : 1 1 0 3 0 6 0 2 2 B 0 0 0 0 0 0 6 4 CR LF
Hex | 3a |31 |31 30|31 3035|3032 |32]42|30|30|30]|30][30]30]|36]|34|—|—]o]oa
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Preset Single Register : 06 ‘

Describes “06" command frame through an example where 00 03 (hex) data is entered in 400002 Register of the Slave device side .

H RTU Mode
(Master > Slave: request frame)
e ls o | & 3 o
3 2 3 L 2 @
3 |2 |3 5 S =
@ ° o @ a a
2 | 2 o = 2
: 8
H L H L L H
Hex | 11|06 |00 01|00 03] —]—
(Slave > Master: response frame)
g ls e | & 3 o
S ls |3 | ¢ g 5
1% 02| 3 ¥ 8
8 [a
o
H L H L L H
Hex | 1106 | 00| 01|00 03] —]—
W ASCIl Mode
(Master - Slave: request frame)
3 2 ® 3 5 o 3
o] = ° ) Q@ [oR Q
2 X 3 Q. <1 S
= (SD, Y @
@ 3
H L H L H - - L H - - Ll L H
ASClI 1 1 0 6 0 0 0 1 0 0 0 3 CR LF
Hex | 3A |31 )31 )30 36|30 303031 ]30]30]30]33]—]—op]oa
(Slave - Master: response frame)
3 & ® 3 5 o *
@ = ° Q Q@ o Q
2 g 2 o g 4
= (SD. 1y @
8 %
o
H L H L H - - L H - - L L H
ASClI 1 1 0 6 0 0 0 1 0 0 0 3 CR LF
Hex | 3A[31]31 3036|3030 ]30]31]30]30]30]33]—]—|op]oa
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Preset Multiple Register : 10
Describes “10” command frame through an example where two consecutive data, “00 0A (hex)”, “01 02 (hex)" are entered in 400002

Register of the Slave device side. (Error Code : 904)

B RTU Mode
(Master > Slave: request frame)
8] %] 8] o =2 0 z a)
S 2 S g g § g Data 3
3 3 S Q = g ~
& |3 3 @ o 3 » o oo )
ES o8 2 a o) [=} S @ S @ 8
= ) c 9 a S« ISER=% ®
< 2 8 2 2 @ —~
2 <7 & @ @ A
Q — - - X
@ 3 D
g 8
H L | H L H H L H
Hex |11 |10 | 00| 01| 00| 02|04 |00 0a|01]02]|—]|—
(Slave - Master: response frame)
e |g |8 B ERS Q
3 |5 |3 S g3 2
3 - 3 5 o = ~
S |s |3 < o< 8
EEl e (2] 8
) = & %
é, <
H L |H L | L H
Hex | 1110 [ 00| 01|00 02| —]—
W ASCIl Mode
(Master > Slave: request frame)
Q T %] 0 o =2 0O T Z
s 8| 2 S ] g i oo
3 | & e 3 5 4 2 s T
o = ° D @ o & @ N ) N
- S g S 2 o o IS SIS
2 e 5 = y S @ Sz
& g e e
&
H LJ|H LJ|H - - L|H - - L|- Ll H - - L - - L
ASClI 1 1 1 0 0 0 0 1 0 0 0 2 0 4 0 0 0 A 1 0 2
Hex | 3A | 3131313030 ]30]41|43|30|30]30]32]30]34]30]30]30]41]30]31 ]3]z
o
3
o
[0}
5
o
H
ASCII CR LF
Hex | — | — |op|oa
(Slave > Master: response frame)
3 e ® 3 5 3 2 2
o = i) o @ n g a
- o8 3 Q o S
= o 2 € 9 &
8 <& =
é ~
H LJ|H L|H - - LI|H - - H
ASCII 1 1 1 0 0 0 0 1 0 0 0 2 CR LF
Hex | 3A |31 ] 313031 |30 303031 |30]|30]3]32|—|—|o]oa
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A.5 LRC/CRC Generation

(1) LRC Generation

The Longitudinal Redundancy Check (LRC) field is one byte, containing an 8-bit binary value. The LRC value is calculated by the
transmitting device, which appends the LRC to the message. The receiving device recalculates an LRC during receipt of the message,
and compares the calculated value to the actual value it received in the LRC field. If the two values are not equal, an error results.

The LRC is calculated by adding together successive 8-bit bytes in the message, discarding any carries, and then two's
complementing the result. The LRC is an 8-bit field, therefore each new addition of a character that would result in a value higher
than 255 decimal simply ‘rolls over’ the field's value through zero. Because there is no ninth bit, the carry is discarded automatically.

A procedure for generating an LRC is:

1. Add all bytes in the message, excluding the starting ‘colon” and ending
CRLF. Add them into an 8-bit field, so that carries will be discarded.
2. Subtract the final field value from FF hex (all 1's), to produce the

ones—complement.

3. Add 1 to produce the twos—complement.

— Placing the LRC into the Message

When the 8-bit LRC (2 ASCII characters) is transmitted in the message, the high-order character will be transmitted first, followed
by the low—order character.

For example, if the LRC value is 61 hex (0110 0001):

colon| Aadr| Func | °®2 | Data| Data| Data| Data| "RC| “FC| cr | LF
Count Hi Lo
& 1
— Example

An example of a C language function performing LRC generation is shown below.

The function takes two arguments:

unsigned char *auchMsg ; // A pointer to the message buffer containing
// binary data to be used for generating the LRC
unsigned short usDatalen ; // The quantity of bytes in the message buffer.

The function returns the LRC as a type unsigned char.

— LRC Generation Function

static unsigned char LRC(auchMsg, usDatalen)

unsigned char *auchMsg ; /* message to calculate LRC upon */
unsigned short usDatalen ; /* quantity of bytes in message */
{
unsigned char uchLRC = 0 ; /* LRC char initialized */
while (usDataLen—) /* pass through message buffer */
uchLRC += *auchMsg++ ; /* add buffer byte without carry */

return ((unsigned char)(=((char)uchLRC))) ; /* return twos complement */
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(2) CRC Generation
The Cyclical Redundancy Check (CRC) field is two bytes, containing a 16-bit binary value. The CRC value is calculated by the

transmitting device, which appends the CRC to the message. The receiving device recalculates a CRC during receipt of the message,

and compares the calculated value to the actual value it received in the CRC field. If the two values are not equal, an error results.

The CRC is started by first preloading a 16-bit register to all 1's. Then a process begins of applying successive 8-bit bytes of the
message to the current contents of the register. Only the eight bits of data in each character are used for generating the CRC. Start
and stop bits, and the parity bit, do not apply to the CRC.

During generation of the CRC, each 8-bit character is exclusive ORed with the register contents. Then the result is shifted in the
direction of the least significant bit (LSB), with a zero filled into the most significant bit (MSB) position. The LSB is extracted and
examined. If the LSB was a 1, the register is then exclusive ORed with a preset, fixed value. If the LSB was a 0, no exclusive OR takes
place.

This process is repeated until eight shifts have been performed. After the last (eighth) shift, the next 8-bit character is exclusive
ORed with the register's current value, and the process repeats for eight more shifts as described above. The final contents of the
register, after all the characters of the message have been applied, is the CRC value.

A procedure for generating a CRC is:

1. Load a 16-bit register with FFFF hex (all 1's). Call this the CRC register.
2. Exclusive OR the first 8-bit byte of the message with the low—order byte of the 16-bit CRC register, putting the result

in the CRC register.

3. Shift the CRC register one bit to the right (toward the LSB), zero—filling the MSB. Extract and examine the LSB.

4. (If the LSB was 0): Repeat Step 3 (another shift). (If the LSB was 1): Exclusive OR the CRC register with the polynomial
value A001 hex (1010 0000 0000 0001).

5. Repeat Steps 3 and 4 until 8 shifts have been performed. When this is done, a complete 8-bit byte will have been
processed.

6. Repeat Steps 2 through 5 for the next 8-bit byte of the message. Continue doing this until all bytes have been
processed.

7. The final contents of the CRC register is the CRC value.

8. When the CRC is placed into the message, its upper and lower bytes must be swapped as described below.

- Placing the CRC into the Message

When the 16-bit CRC (two 8-bit bytes) is transmitted in the message, the low-order byte will be transmitted first, followed by the
high-order byte.

For example, if the CRC value is 1241 hex (0001 0010 0100 0001):

Data CR CE
Addr Func Count Data Data Data Data Clo Chi
ER 12

— Example

An example of a C language function performing CRC generation is shown on the following pages. All of the possible CRC values
are preloaded into two arrays, which are simply indexed as the function increments through the message buffer.

One array contains all of the 256 possible CRC values for the high byte of the 16-bit CRC field, and the other array contains all of
the values for the low byte. Indexing the CRC in this way provides faster execution than would be achieved by calculating a new

CRC value with each new character from the message buffer.

Note This function performs the swapping of the high/low CRC bytes internally. The bytes are already swapped in the
CRC value that is returned from the function. Therefore the CRC value returned from the function can be directly placed

into the message for transmission.

The function takes two arguments:

unsigned char *puchMsg ; //A pointer to the message buffer containing
//binary data to be used for generating the CRC
unsigned short usDatalen ; //The quantity of bytes in the message buffer.

The function returns the CRC as a type unsigned short.
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— CRC Generation Function

unsigned short CRC16(puchMsg, usDataLen)

unsigned char *puchMsg ; /* message to calculate CRC upon */

unsigned short usDatalen ; /* quantity of bytes in message */

{
unsigned char uchCRCHi = OxFF ; /* high byte of CRC initialized */
unsigned char uchCRCLo = OxFF ; /* low byte of CRC initialized */
unsigned ulndex ; /* will index into CRC lookup table */
while (usDataLen—) /* pass through message buffer */

{
ulndex = uchCRCHi » *puchMsgg++;  /* calculate the CRC */
uchCRCHi = uchCRCLo ~ auchCRCHi[ulndex} ;
uchCRCLo = auchCRCLo[ulndex] ;

}

return (uchCRCHi << 8 | uchCRCLo) ;

— High-Order Byte Table

/* Table of CRC values for high—-order byte */

static unsigned char auchCRCHi[] = {

0x00, 0xC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41, 0x01, 0xCO, 0x80, 0x41, 0x00, OxC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41,
0x00, 0xC1, 0x81, 0x40, 0x00, OxC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41, 0x01, 0xCO, 0x80, 0x41, 0x00, OxC1, 0x81, 0x40,
0x00, 0xC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41, 0x00, OxC1, 0x81, 0x40, 0x01, 0xCO, 0x80, Ox41, 0x01, 0xCO, 0x80, 0x41,
0x00, 0xC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41, 0x00, OxC1, 0x81, 0x40, 0x00, OxC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41,
0x00, 0xC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41, 0x01, 0xCO, 0x80, 0x41, 0x00, OxC1, 0x81, 0x40, 0x00, OxC1, 0x81, 0x40,
0x01, 0xCO, 0x80, 0x41, 0x01, 0xCO, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41, 0x00, OxC1, 0x81, 0x40,
0x00, 0xC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41, 0x01, 0xCO, 0x80, 0x41, 0x00, OxC1, 0x81, 0x40, 0x00, OxC1, 0x81, 0x40,
0x01, 0xCO, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41, 0x01, 0xCO, 0x80, 0x41, 0x00, OxC1, 0x81, 0x40,
0x00, 0xC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41, 0x01, 0xCO, 0x80, 0x41, 0x00, OxC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41,
0x00, 0xC1, 0x81, 0x40, 0x00, OxC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41,
0x01, 0xCO, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41, 0x00, OxC1, 0x81, 0x40, 0x00, OxC1, 0x81, 0x40,
0x01, 0xCO, 0x80, 0x41, 0x01, 0xCO, 0x80, 0x41, 0x00, OxC1, 0x81, 0x40, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41,
0x00, 0xC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41, 0x01, 0xCO, 0x80, 0x41, 0x00, OxC1, 0x81, 0x40

}

— Low-Order Byte Table

/* Table of CRC values for low—order byte */

static char auchCRCLo[] = {

0x00, 0xCO, 0xC1, 0x01, 0xC3, 0x03, 0x02, 0xC2, 0xC6, 0x06, 0x07, 0xC7, 0x05, 0xC5, 0xC4, 0x04, 0xCC, 0x0C, 0xOD, OxCD,
OxOF, OxCF, OxCE, OxOE, OxOA, OxCA, 0xCB, 0x0B, 0xC9, 0x09, 0x08, 0xC8, 0xD8, 0x18, 0x19, 0xD9, 0x1B, OxDB, OxDA, Ox1A,
Ox1E, OxDE, OxDF, Ox1F, OxDD, 0x1D, 0x1C, OxDC, Ox14, 0xD4, 0xD5, 0x15, 0xD7, 0x17, 0x16, 0xD6, 0xD2, 0x12, 0x13, 0xD3,
0x11, 0xD1, 0xDO, 0x10, OxFO, 0x30, 0x31, OxF1, 0x33, OxF3, OxF2, 0x32, 0x36, OxF6, OxF7, 0x37, OxF5, 0x35, 0x34, OxF4,
0x3C, OxFC, OxFD, 0x3D, OxFF, Ox3F, Ox3E, OxFE, OxFA, Ox3A, 0x3B, OxFB, 0x39, OxF9, OxF8, 0x38, 0x28, OxE8, OxE9, 0x29,
OxEB, 0x2B, Ox2A, OxEA, OxEE, Ox2E, Ox2F, OxEF, 0x2D, OxED, OxEC, 0x2C, OxE4, 0x24, 0x25, OxE5, 0x27, OxE7, OxE6, 0x26,
0x22, OxE2, OxE3, 0x23, OxE1, 0x21, 0x20, OxEO, OxAO, 0x60, 0x61, OxA1, 0x63, O0xA3, 0xA2, 0x62, 0x66, OxA6, OxA7, Ox67,
0xA5, 0x65, 0x64, 0xA4, 0x6C, OxAC, OxAD, 0x6D, OxAF, Ox6F, Ox6E, OxAE, OxAA, Ox6A, 0x6B, OxAB, 0x69, 0xA9, 0xA8, 0x68,
0x78, 0xB8, 0xB9, 0x79, OxBB, 0x7B, Ox7A, OxBA, OxBE, Ox7E, Ox7F, OxBF, Ox7D, OxBD, OxBC, 0x7C, OxB4, 0x74, 0x75, O0xB5,
0x77, 0xB7, 0xB6, 0x76, 0x72, 0xB2, 0xB3, 0x73, 0xB1, 0x71, 0x70, 0xBO, 0x50, 0x90, 0x91, 0x51, 0x93, 0x53, 0x52, 0x92,
0x96, 0x56, 0x57, 0x97, 0x55, 0x95, 0x94, 0x54, 0x9C, 0x5C, 0x5D, 0x9D, Ox5F, Ox9F, Ox9E, Ox5E, Ox5A, 0x9A, 0x9B, O0x5B,
0x99, 0x59, 0x58, 0x98, 0x88, 0x48, 0x49, 0x89, 0x4B, 0x8B, Ox8A, Ox4A, Ox4E, Ox8E, Ox8F, Ox4F, 0x8D, 0x4D, 0x4C, 0x8C,
0x44, 0x84, 0x85, 0x45, 0x87, 0x47, 0x46, 0x86, 0x82, 0x42, 0x43, 0x83, 0x41, 0x81, 0x80, 0x40

b
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